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� Start Outlook. 

� Navigate within Outlook. 

� Use the Outlook bar. 

� Use the Folder List. 

� Use the Office Assistant. 

Until personal computers became popular, managing work-related data meant 

recording and tracking information on paper stored in several different places. 

For example, a businessperson might record appointments and meetings in a 

day planner, while keeping phone number and addresses in a card file. Brief 

reminders were jotted down on small sticky notes. Other important business 

information was stored in files and folders in a desk drawer or filing cabinet. 

Although many people have grown accustomed to these organizational 

approaches, Microsoft Outlook provides a better way to store, track, and 

integrate business and personal information. With Outlook, you can store and 

access important information in a single location on a personal computer. For 

example, you can use Outlook’s electronic calendar to record meetings and 

appointment dates and times. Outlook can even sound an alarm or display a 

reminder on your computer screen when you have an appointment. You can 

record brief reminders to yourself on Outlook notes, which resemble sticky 

notes, and these notes can be displayed on your screen at any time for easy 

reference. You can use Outlook to record your daily or weekly tasks and check 

them off as you complete them. Outlook has an address book in which you can 

record phone numbers, addresses, e-mail addresses, and other information 

about your business and personal contacts. You can even view Web sites 

directly from Outlook, as well as open other Microsoft Office documents. The 

power of Outlook lies in knowing how to use all of its capabilities to organize 

information efficiently. 

In this lesson, you will tour many of the elements of Outlook to become 

familiar with it. You will start Outlook and view different folders, which are 

containers for programs and files. You will also take a closer look at the 

Outlook bar and the shortcuts that you find there. Click a shortcut, displayed 

as an icon on the Outlook bar, to display the contents of the corresponding 

folder or file. Finally, you will learn how to use the Help system in Outlook to 

find answers to your questions about using Outlook as a powerful tool to 

organize your data. 

No practice files are required to complete the exercises in this lesson. 

LESSON 4 
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As with all Microsoft Office programs, there are several different ways to open 

Outlook. One method is to click the Start button on the Windows taskbar, point 

to All Programs, and click Microsoft Outlook. This option is always available, 

even if you are using another Microsoft Office program. 

You can also add the Outlook icon to your desktop, then simply double-click 

the icon to start Outlook. Using the icon is faster and easier than using the Start 

button on the Windows taskbar. To add an Outlook icon to your desktop, click 

the Start button on the Windows taskbar, point to All Programs, hold down the 

Ctrl key, and drag the Microsoft Outlook icon onto your desktop. This process 

adds the icon to your desktop without removing it from the Start menu. 

The first time you start Outlook, the Inbox folder is displayed in the Outlook 

window. Use the main window to view and access all Outlook components. 

In this exercise, you start Microsoft Outlook. 

1 On the Windows taskbar, click the Start button, point to All 

Programs, and click Microsoft Outlook. 

Outlook starts. 

2 If necessary, click the Maximize button in the upper-right corner of 

the Outlook window. 

The Outlook window expands to fill the entire screen. 

 

You will learn more about the 

Inbox folder later in this 

lesson. 

If you are opening Outlook for 

the first time, the Office 

Assistant (the animated 

paper clip character) might 

be displayed. To close the 

Office Assistant, right-click 

the paper clip, and click 

Close on the shortcut menu 

that appears. You will learn 

more about the Office 

Assistant later in this lesson. 
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The Outlook window contains buttons, icons, menu commands, and other 

elements that enable you to navigate within Outlook and use Outlook 

effectively. The contents of this window change as you click buttons and icons 

and choose options. 

 

The table on the following page describes the basic functions of the elements 

displayed in the Outlook window. 
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Element Description 

Title bar Identifies the application currently running (in this case, 

Outlook) and the active Outlook folder. 

Menu bar Lists the names of the menus available in the current 

Outlook window. A menu displays a list of commands the 

application can perform.  

Standard toolbar Displays buttons that enable you to quickly access 

commonly used commands for the application. 

Outlook bar Displays shortcuts to the contents of folders available in 

Outlook, such as the Inbox and Calendar. The Outlook bar 

is expandable and contains two or three groups of shortcuts: 

Outlook Shortcuts, My Shortcuts, and Other Shortcuts (also 

called Other). To hide or display the Outlook bar, click the 

Outlook bar option on the View menu. 

Folder List Displays a list of available Outlook folders. Click a folder in 

the list to view the folder’s contents. To display the Folder 

List, select the Folder List option on the View menu. To 

view the Folder List briefly, click the name of the current 

folder in the Folder Banner. The first time you use Outlook, 

you will have one personal folder in the Folder List for each 

component on the Outlook bar. If your organization uses 

Microsoft Exchange Server, you might also see public 

folders that can be accessed by other network users. Use the 

Folder List to move items from one folder to another, create 

folders within folders, and much more. 

Folder Banner Displays the name of the open folder. If the Folder List is 

not displayed, click the name of the folder in the Folder 

Banner to view the list of available folders. 

Items Information displayed in Outlook. For example, in the 

Inbox, each message is an item; in Contacts, the contact 

record is an item. 

Shortcut An icon on the Outlook bar. Click a shortcut and Outlook 

displays the contents of the corresponding folder or file. 

Status Bar As you use the Outlook bar or Folder List to switch to 

different Outlook folders, the Status bar displays the 

number of items that are in a specific folder. For example, 

when you open Contacts, the Status bar displays the number 

of contacts in the folder. 

Preview Pane A section of the Inbox window that displays the text of the 

selected message. The Preview Pane is displayed by 

default in the Outlook window. To hide it, deselect Preview 

Pane on the View menu. 
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Outlook has a default feature that enables you to personalize your menus. The 

first time you open a menu in Outlook, you see a short menu that displays the 

commands that are most frequently used by Outlook users. You also see two 

small arrows at the bottom of the menu. These arrows are used to expand the 

menu to display more options. You can expand the menu in two ways: click the 

arrows at the bottom of the menu or wait a few seconds for the menu to expand 

on its own. When you click a command on the expanded menu, Outlook 

immediately displays this command on the short menu. Outlook continues to 

adapt. Over time, if you stop using this command, it is removed from the short 

menu. The command will be displayed on the expanded menu. 

In this exercise, you navigate through different areas of the Outlook window. 

1 On the menu bar, click Tools. 

The short Tools menu is displayed. 

 

2 Click anywhere outside the menu. 

The menu closes. 

3 On the menu bar, click Tools. 

The short Tools menu is displayed. 

4 Click the double arrows at the bottom of the short Tools menu. 

The expanded Tools menu is displayed, as shown in the illustration 

on the following page. 

If you prefer to see the 

expanded menus instead of 

the short menus, open the 

Tools menu, click Customize, 

click the Options tab, select 

the Always show full menus 

check box, and click Close. 
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5 On the bottom-right side of the Outlook bar, click the down arrow. 

The Outlook bar scrolls down. 

6 On the upper-right side of the Outlook bar, click the up arrow. 

The Outlook bar scrolls up. 

7 On the Folder Banner, click the folder name Inbox. 

The Folder List is displayed, as shown in the illustration on the 

following page. 

If possible, all the Outlook 

shortcuts are visible in the 

Outlook bar at the same time. 

If the size of your monitor or 

your display settings prevents 

this, up and down arrows 

enable you to scroll the 

Outlook bar.  
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8 Click outside the Folder List. 

The Folder List is no longer displayed. 
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The Outlook bar displays icons that represent the components available in 

Outlook. Each icon is also a shortcut to the contents of frequently used folders, 

such as the Inbox, Calendar, and Contacts folders. When you click one of the 

shortcuts, the contents of the folder are displayed. For example, if you click the 

Calendar shortcut, the content of the Calendar folder—a calendar containing 

your appointments—is displayed. 

Outlook uses the term folder to describe how Outlook’s functions and common 

items are divided within Outlook. For example, the Inbox folder contains  

e-mail messages that you have received and enables you to create messages 

within the Inbox folder. The Tasks folder contains a list of activities that you 

need to perform and enables you to create tasks. You cannot create a task in the 

Inbox folder or create a message in the Tasks folder. When you view the 

folders in Outlook, you’ll notice that the appearance and options differ in each 

folder. For that reason, you can think of each folder as a separate program 

within Outlook even though the functions work together without a seam. 

The Outlook bar contains three groups: Outlook Shortcuts, My Shortcuts, and 

Other Shortcuts (or simply Other). The name of each group name is displayed 

on its own bar. Each group contains shortcuts to specific folders.  

The Outlook Shortcuts group contains seven shortcuts to the most frequently 

used folders in Outlook: Outlook Today, Inbox, Calendar, Contacts, Tasks, 

Notes, and Deleted Items. The My Shortcuts group contains several standard 

folders: Drafts, Outbox, Sent Items, Journal, and Outlook Update. The Other 

Shortcuts (or Other) group contains folders that also appear in Windows 

The Folder List closes if you 

click outside the Folder List 

window. To keep the Folder 

List open, click the Push Pin 

button. 

Even though the Inbox, 

Contacts, Tasks, and other 

Outlook features are called 

“folders,” you will sometimes 

see them referred to by name 

alone (for example, “the 

Inbox”) rather than by name 

and identifier (for example, 

“the Inbox folder”). 
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Explorer: My Computer, My Documents, and Favorites. These folders enable 

you to access a file while you’re using Outlook, eliminating the need to open 

Windows Explorer. You can simply open the file from within Outlook. 

The Outlook folders are described in the following table. 
 

Folder Group Description 

Outlook 

Today 

Outlook Shortcuts Provides a snapshot of your day by 

listing your appointments, identifying 

tasks, and displaying the number of 

available e-mail messages 

Inbox Outlook Shortcuts Stores the e-mail messages that you 

receive 

Calendar Outlook Shortcuts Displays a calendar and appointment 

book to track your schedule 

Contacts Outlook Shortcuts Stores the names, phone numbers, 

addresses, and other information about 

the people with whom you 

communicate 

Tasks Outlook Shortcuts Displays a to-do list of your personal 

and business tasks 

Notes Outlook Shortcuts Stores information on electronic sticky 

notes, such as ideas, grocery lists, or 

directions 

Deleted Items Outlook Shortcuts Temporarily stores the items that you 

delete until you permanently delete 

them 

Drafts My Shortcuts Temporarily saves messages that have 

not been completed 

Outbox  My Shortcuts Holds completed e-mail messages 

until they are sent to recipients 

Sent Items My Shortcuts Stores copies of the e-mail messages 

that you send 

Journal My Shortcuts Displays a history of your Microsoft 

Office activities in a timeline format 

Outlook 

Update 

My Shortcuts Accesses the Internet to find the latest 

additions or patches provided by 

Microsoft for the Outlook application 

Shortcuts can be moved from 

one group to another on the 

Outlook bar, removed, or 

added. Therefore, shortcuts 

might be located in a different 

group on your computer. If a 

shortcut does not appear in 

the specified group, look for it 

in a different group. 
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My Computer  Other Shortcuts Provides access to other drives, 

folders, and files on your computer or 

network 

My 

Documents 

Other Shortcuts Provides access to documents or files 

created in other programs 

Favorites Other Shortcuts Stores shortcuts to important folders 

and Web addresses 

In this exercise, you use the Outlook bar to view different Outlook folders. 

1 On the Outlook bar, click the Outlook Today shortcut. 

The contents of the Outlook Today folder are displayed. 

 

2 On the Outlook bar, click the Calendar shortcut. 

The contents of the Calendar folder are displayed. 

You will learn how to use the 

Inbox to send and receive  

e-mail messages in the next 

lesson. 
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3 On the Outlook bar, click the Contacts shortcut. 

The contents of the Contacts folder are displayed. 

 

4 On the Outlook bar, click the Tasks shortcut. 

The contents of the Tasks folder are displayed. 
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5 On the Outlook bar, click the Notes shortcut. 

The contents of the Notes folder are displayed. 
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6 On the Outlook bar, click the down arrow if the Deleted Items 

shortcut isn’t visible. Click the Deleted Items shortcut in the Outlook 

bar. 

The contents of the Deleted Items folder are displayed. You can 

drag any item from any Outlook folder onto the Deleted Items 

shortcut on the Outlook bar to remove the item from a folder and 

store it temporarily in the Deleted Items folder.  

 

7 On the Outlook bar, click the My Shortcuts group bar. 

The shortcuts available in the My Shortcuts group are displayed. 

 

Items are not removed from 

your hard drive until you 

select Empty “Deleted Items” 

Folder on the Tools menu. 
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8 On the Outlook bar, click the Other Shortcuts group bar (or Other 

group bar). 

The shortcuts available in the Other Shortcuts (or Other) group are 

displayed. 

 

9 On the Outlook bar, click the Outlook Shortcuts group bar. 

The shortcuts available in the Outlook Shortcuts group appear 

again. 
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The Favorites folder is a shortcut to Web sites and other folders that you 

frequently use or don’t want to forget. The Favorites folder is located in the 

Other Shortcuts (or Other) group. 

 

To add a Web site to the list of Favorites when you are connected to the 

Internet, follow these steps: 

1 On the Windows taskbar, click the Start button and select Internet 

Explorer. 

2 In the Address box, type the address of the Web site you want to 

add and press Enter. 

3 After the Web page is displayed, select Add to Favorites on the 

Favorites menu. 

4 Click OK to accept the default title line as the name of the Favorite. 

OR 

Type a new name and click OK. 

To add a folder to the list of Favorites, follow these steps: 

1 On the Windows taskbar, click the Start button, point to All 

Programs, and click Windows Explorer. 

You can add frequently 

visited folders or Web sites to 

the Favorites folder.  
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2 Click the folder you want to add, click Add to Favorites on the 

Favorites menu, and click OK to accept the default title line as the 

name of the Favorite. 

To access a favorite Web site or folder from Outlook, follow these steps: 

1 On the Outlook bar, click the Other Shortcuts group bar (or Other 

group bar). 

2 Click the Favorites folder, and double-click the name of the Web 

site or folder that you want to open. 
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You can also view Outlook folders and their contents by using the Folder List. 

The Outlook bar displays shortcuts of frequently used folders; however, not all 

folders are represented by these shortcuts. The Folder List displays all the 

folders available in Outlook, including the folders represented by shortcuts on 

the Outlook bar. 

The Folder List displays each folder as a small icon followed by the name of 

the folder. When you click a folder’s icon, the contents of the folder are 

displayed. For example, if you click the Contacts shortcut in the Folder List, 

Outlook displays the contents of the Contacts folder, enabling you to view 

contact records. 

In this exercise, you use the Folder List to display many of the same folders 

that you displayed in the previous exercise. 

1 On the Folder Banner, click the folder name Deleted Items. 

The Folder List is displayed. 
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2 In the Folder List, click Inbox. 

The contents of the Inbox folder are displayed and the Folder List 

closes. 

3 On the Folder Banner, click the folder name Inbox. 

The Folder List is displayed. 

4 In the upper-right corner of the Folder List, click the Push Pin 

button. 

The Push Pin button turns into a Close button. The Folder List will 

remain open until you close it. 

5 In the Folder List, click Tasks. 

Outlook displays the contents of the Tasks folder. Note that the 

Folder List remains open. 

6 In the upper-right corner of the Folder list, click the Close button. 

The Folder List closes. 
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Outlook, like all Microsoft Office applications, includes an extensive Help 

system that you can use to learn more about features and options available in 

Outlook. The Office Assistant is an animated character that provides helpful 

information about Outlook topics. By default, the Office Assistant appears as 

an animated paper clip named Clippit. However, you can choose to display the 

Office Assistant as an animated dog, cat, or any one of several other characters. 

 

Help is readily available in Outlook. To view help when the Office Assistant is 

displayed, click the Office Assistant and type your question in the displayed 

box. Use your language of choice to phrase your request—for example, in 

Standard English, you might write “How do you send a message?” or “What is 

in the Journal?” You can simply type a few words, such as “send message” or 

“Journal,” to view information related to those topics. The Office Assistant 

interprets your request and displays topics that match one or more words in 

your request. Click the topic that most closely matches your request. 

In this exercise, you display the Office Assistant and use it to view help on an 

Outlook topic. Hide the Office Assistant to complete the exercise. 

1 On the Standard toolbar, click the Microsoft Outlook Help button. 

The Office Assistant is displayed with a box that asks you to type a 

question and click the Search button. 

To change the Office 

Assistant, right-click the 

Office Assistant and click 

Choose Assistant. Click Next 

to view the various 

animations available and 

click OK when you have 

found one that you like. Only 

the paper clip animation is 

saved onto your hard drive 

during installation, so you will 

need to insert the Microsoft 

Office (or Microsoft Outlook) 

CD-ROM to install a new 

animation. 

You can also select Show the 

Office Assistant on the Help 

menu to display the Office 

Assistant. 
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2 Type How do I send a message? and click the Search button. 

The Office Assistant displays Help topics that are relevant to the 

question you asked. 

3 Click the Send and Receive Messages option. 

An Outlook Help window is displayed that explains how to send 

messages. 

 

4 In the upper-right corner of the Help window, click the Close button. 

The Outlook Help window closes. 

5 Right-click the Office Assistant and click Hide. 

The Office Assistant disappears. 
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In this lesson, you learned how to start Outlook and navigate through the main 

Outlook window. You also learned how to use the Outlook bar and the Folder 

List to display different Outlook folders. Finally, you learned how to use the 

Office Assistant to view more information about Outlook. 

If you are continuing to the next lesson: 

■ On the Outlook bar, click the Inbox shortcut. 

The contents of the Inbox folder are displayed. 

If you are not continuing to other lessons: 

■ In the upper-right corner of the Outlook window, click the Close 

button. 

Outlook closes. 
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1 What is a group? 

2 How do you use the Office Assistant to view help topics in Outlook? 

3 What functionality does the Folder Banner provide? 

4 Identify two ways to display an expanded menu. 

5 What are shortcuts? 

6 List two ways to display an Outlook folder such as the Inbox. 
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Exercise 1: Display the View menu and display the expanded View menu. 

When you open the expanded View menu, move your mouse pointer across 

different menus on the Menu bar to view the results. 

Exercise 2: Display the Folder List and keep it visible. Use the Folder List to 

display the contents of the Contacts folder and the Tasks folder. Use the Office 

Assistant to find out how to hide the Outlook bar. Hide the Outlook bar and 

redisplay it. Close the Folder List. 

Exercise 3: Use the Outlook bar to display the Inbox, Calendar, Contacts, 

Tasks, and Notes. Observe the differences in the Standard toolbar as you select 

each shortcut in the Outlook Shortcuts group. 

Exercise 4: Visit a Web site. Add it to your Favorites so you can access it 

through Outlook. 

Exercise 5: Display the Office Assistant. Type favorites in the box and view 

the available help topics. 


